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Using GIS Applications for Census Data

in Watershed Analysis

Watershed Science Institute

National Cartography and Geospatial Center

PurposeThis technical note describes the use of sociodemographic data in
watershed studies by outlining a basic method for processing and
using U.S. Census 1990 Tiger/Line data. A recommendation of data
sources and methods of data use are discussed to promote demo-
graphic analysis within special study watersheds. One aspect of this
technical note is to improve accuracy of watershed census data
through use of Geographic Information Systems (GIS) capabilities.

Watershed research and applying conservation practices within
watersheds are based on more geographic and scientific data than
ever before. Environmental factors, such as water quality, wildlife
and fish habitat, soil erosion, and air pollution, and constituent
indicators are identified and monitored closely to show changes in
overall watershed health. However, to look at environmental factors
without their relationship to human conditions is shortsighted.
Environmental data assessments taken in local watersheds can be
enhanced or augmented with population data and sociodemographic
characteristics. Sociodemographic data can strengthen the overall
understanding of many aspects of watershed studies.

Descriptive demographics of the study area are routinely a part of
watershed inventories. They are useful for the understanding of the
economic and social characteristics of the human aspect of
SWAPAH (soil, water, air, plant, animal, and human). Demographics
identify important social characteristics, which may assist in plan-
ning by providing a better understanding of the project effects on
society or groups in the study area. They are useful for identification
of limited resource communities, and the data provides for the social
accounts required by the National Environmental Protection Act
(NEPA).

This information allows us to better consider environmental justice
concerns. Further, the expanding capabilities of GIS allow planners
to integrate increasing amounts of spatial data and use more sophis-
ticated computational models. Thereby the capacity to use demo-
graphics in watershed studies continues to improve and to also
become more accurate.

Generally, U.S. census population data do not coincide with water-
shed boundaries. The census information is collected and published
based on political boundaries, such as counties, or on a smaller scale
in tracts or blocks. Estimating the watershed population and associ-
ated demographic characteristics relies upon various approaches,
none of which provide for good accuracy.

Introduction



WSSI Technical Note ___

2

One approach is to identify the counties in the watershed, and obtain
census data for each of the counties. What follows is a description of
the social characteristics for the watershed by simply discussing the
aggregated counties’ data. Sometimes planners would more sharply
define the watershed population data by means of visual adjustments
based upon comparisons of county and watershed maps. One aspect
of this technical note is to improve accuracy of watershed census
data through use of GIS capabilities.

Watershed planning also relies on manual delineation with hardcopy
maps of watershed boundaries. Natural resource data are collected
and recorded for watersheds using various manual-mapping tech-
niques. Many areas of the country lack digital watershed data, al-
though over time this has been diminishing, and this trend should
continue to improve in the future. This lack of digital data may be
caused by the need for upfront investments in time and other costs
to establish the data layers needed for planning. Use of GIS will
become more cost effective as more and more natural resource data
layers become available. Cross Agency sharing of this type of infor-
mation will also assist planning. As the technology itself develops
and improves the capacity for better planning at reduced cost will be
substantial.

Eventually, the use of an all GIS approach for watershed planning
will be the Agency norm. This achievement would be consistent with
the USDA Service Center, Geographic Information System Strategy
document of August 1998. In part it says,

Integrating GIS technology into service center business operations
is crucial for service centers to provide timely program delivery,
reduce customer burdens, and remain cost effective. As cus-
tomers increasingly apply GIS technology within their own
operations, they expect USDA Service Centers to deliver prod-
ucts and service that take advantage of similar technology….

The GIS Strategy document is available at
http://www.ftw.nrcs.gov/nsdi_node.html

Effective use of GIS in watershed scale studies of conservation
practice applications requires a clearly defined problem, and a meth-
odological approach to assessment and analysis. This technical note
guides users on the inclusion of demographic data in watershed
research, and outlines a tutorial on how to acquire, manipulate, and
apply U.S. Census data to watershed studies.

A basic understanding of Environmental Systems Research

Institutes’ (ESRI) ArcView software and terminology, such as

how to add themes, avenue scripts, and edit tables, is required

to follow the examples presented in this technical note.1

1/ For information on the contents of this Technical Note, contact authors Rob
Veerland, National Cartography & Geospatial Center, Fort Worth, Texas, at
817 509-3374, or Tom Noonan, Watershed Science Institute, 304 293-4832 Ext. 4479.
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The watershed practitioner will, by following the example, access
census data for the Rocky River Watershed, North Carolina, and
calculate population densities for selected subwatersheds. By com-
pleting this example the user will become familiar with the pro-
cesses needed to interpolate census data on watershed boundaries
within a desktop GIS. This methodology is intended only to familiar-
ize users with the process in ArcView and not as a primer on the
fundamentals of demographic analysis. However, a supplemental
discussion about data limitations and using a weighted average
approach to estimating selected population attributes is provided.

The Rocky River Watershed, about 1,444 square miles, is located in
south central North Carolina. The watershed consists of about 55
percent forest, pasture, and hayland and is impacted by the Charlotte
metropolitan area. Other urban centers include Kannapolis,
Albemarle, and Monroe (figure 1).

This example is based on the Rocky River Watershed boundaries,
which were delineated by Natural Resources Conservation Service
(NRCS) North Carolina State Office personnel. The Rocky River
Watershed was further subdivided into subwatersheds using the
United States Geological Survey (USGS) 1:100,000 topographic
mapsheets. Using these map sheets, drainage points were chosen
and drainage through those points calculated to identify equal area
subwatersheds. The subwatersheds were then digitized using ESRI’s
ArcInfo software.

Figure 1 Rocky River Watershed area, North Carolina.

Data acquisition
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To begin the tutorial, several files are necessary and a directory
structure must be created. The directory structure used in this tuto-
rial starts at the root level and is called watergis. Two subdirectories
—one called original and one called working—exist under watergis.
An example on the C drive would be c:/watergis/original and C:/
watergis/working. Sample data including Topologically Integrated
Geographic Encoding and Referencing (Tiger) shape files and the
STF1A tables in this example are available at

ftp://ftp.ftw.nrcs.usda.gov/pub/ams/watershed/

Download the file called Rocky.zip.

To begin analysis of the watershed using demographic data, a com-
mon attribute identifying state and county fips, tract, block group,
and block must exist in both the STF1A data and the Tiger/Line files.
STF1A data, which are extracts from the section on STF1A, will
guide you through this process. Most of the Tiger/Line processing has
been completed by commercial vendors and can be purchased in
multiple data formats. ESRI has also made available on the Internet
the U.S. Tiger/Line files in shape file format. The ArcData Online Web
page is:

http://www.esri.com/data/online/index.html

The zip file containing the sample data described previously should
be downloaded and located in the directory:

<drive letter>:\watergis\original

Open a new ArcView project and begin adding the themes from the
directory:

<drive letter>:\watergis\original

Add each of the following three themes:
1. Bg37_d90.shp
2. North_caro.shp
3. Sub_Rocky.shp

Set the working directory to <drive letter>:\watergis\ by making
the view active, selecting the File menu and clicking on the Set

Working Directory option. Figure 1 shows the spatial layers that
should be loaded in ArcView.

When the themes have been loaded into ArcView, the View proper-
ties must be set. This step involves setting the Projection parameters
and the View units. ArcView is able to simulate different projections
if the data is in a geographic coordinate system.

Use the View dropdown menu and select the View properties option.
Next set each of the four properties in the popup box.

1. Map Unit: Meters
2. Distance Units: Meters
3. Projection: Category: Projections of the United States
4. Type: Albers Equal-Area (Conterminous United States)

Data preparation
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Access the tables for each theme by selecting each theme then click-
ing Attribute Table button on the button bar. Open the stf1a_1.dbf
file in ArcView by adding a table from the project window. The
stf1a_1.dbf file is complete for North Carolina and must be queried to
select the proper records to join to the Tiger shape files. In ArcView,
query the stf1a_1.dbf table using the Query Builder (figure 2) button
on the toolbar and type in the query ([Sumlev] = 150) and
([Geocomp] = 00). Querying the [Sumlev] = 150 selects all records
that identify blockgroups. Using logical operators, such as and, you
can identify records that have a statewide geographic component by
selecting [Geocomp] = 00. Export the selected records as a new .dbf
table in the working directory and name the file stf1a_1bg.dbf.

1. Add the table named stf1a_1bg.dbf to ArcView and edit the table.
2. Add a new field called Blkg_key as a string field that has a width

of 16.
3. Use the Query Builder button on the toolbar and query the field

[Tractbna] with the equation ([Tractbna].count = 4).
4. Select the field Blkg_key and then use the Calculate button on the

toolbar and type [Tractbna] + 00 (figure 3).

STF1A file

Figure 2 ArcView query box.

Figure 3 ArcView field calculator
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5. Use the Switch Selection button on the toolbar to select the non-
selected records.

6. Use the Calculate button on the toolbar and calculate the field
[Blkg_key] as [Tractbna].

7. Clear the selection by using the Select None button on the
toolbar.

8. Use the Calculate button on the toolbar and calculate the
Blkg_key field with the equation '[Blkg_key] = [Statefp] + [Cnty] +
[Blkg_key] + [Blckgr]'.

9. Save edits and stop editing.

The stf1a_gb.dbf table is a simplified version of what the user should
have once the edits are saved (figure 4).

Join the table stf1a_1gb.dbf with the table of the TIGER file
Bg37_d90.shp. First highlight the field [Blkg_key] on the
Stf1a_1gb.dbf table and then the field [Geoid] on the Bg37_d90.shp
table. Be sure that the table Attributes of BG37_d90.shp is active
window. Use the Join button on the toolbar to perform a one-to-one
relationship join.

Figure 4 Simplified version of table following editing.
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The next step is to calculate feature geometry for each theme. An
avenue script can be added to the project to calculate the [Area],
[Perimeter], and [Acres] for each polygon. ESRI has placed an
avenue The <drive letter>:\ designation is the drive on which
ArcView has been installed. If you are using a Network version of
ArcView, contact your system administrator to find the script. To
run this process, add the script calcare.ave to ArcView and compile
it using the Compile button on the toolbar (figure 5).

Directions on how to run the script are available in the script
header. The View properties, such as projection, and units must be
set to receive correct values from this script. Set the projection to
Albers and the units to Meters for this example.

1. Make the View active.
2. Select the theme Bg37_d90.shp and then holding the shift key

select the theme Sub_Rocky.shp.
3. Make the script active and click the Run button on the toolbar.

The table for each theme selected should now have a field for
[Area], [Perimeter], and [Acres].

Figure 5
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The next step is to determine the population density per acre. Begin
by making the table Attributes of Bg37_d90.shp editable and adding a
new field called [pop_acre] as a numeric field that has a width of 16
and 3 decimal places.

1. Calculate [pop_acre] = [P0010001] / [Acres].

Figure 6 shows the result of the table calculation.

Now that the data are organized and the STF1A data has been joined
with the 1990 TIGER/Line files, analyses can begin of individual
subwatersheds. The following description uses simple areal interpo-
lation. An even population distribution throughout the blockgroup
and subwatershed is assumed. Areal interpolation transfers a per-
centage of evenly distributed population from the blockgroup bound-
aries to the subwatershed boundaries.

Select the GeoProcessing wizard under the View menu, a new
window will open. Select the Intersect option. Enter the TIGER/Line
file Bg37_d90.shp as the input theme and the overlay subwatershed
theme as Sub_Rocky.shp. Specify the output file as <drive

letter>:\watergis\working\itsct1.shp. When complete the file
itsct1.shp contains the attributes of both the Bg37_d90.shp file and
the Sub_Rocky.shp file.

Data analysis

Figure 6 Attributes of Bg37_d90.shp table with addition of [pop_acre].
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Run the ‘calcacre.ave’ script on the itsct1.shp file to create new items
for [Area], [Perimeter], and [Acres]. Edit the attributes of itsct1.shp
by clicking the Open Theme Table button on the toolbar and set
the table to start editing. Add a new field called [Its_pop] as a nu-
meric field with a width of 16 and 0 decimal places.

1. Calculate [Its_pop] = [pop_acre] x [Acres].

Figure 7 is a simplified version of the table.

Calculate the population for each subwatershed by summarizing—
select the [Drain_id] column and then use the Summarize button on
the toolbar. Next, select the [Its_pop] in the Field box and sum in
the Summarize by: box. Save the summary as sub_population.dbf in
the <drive letter>:\watergis\working\ directory (figure 8).

Figure 7 Simplified version of Open Theme table.

Figure 8 Summary table definiion.
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Next, add a table and select sub_population.dbf as the file to
open. Join the Sub_population.dbf table by selecting the [Drain_id]
and then selecting the table for the Sub_Rocky.shp. Select the
[Drain_id] column and click the Join Tables button on the toolbar.
Now the total population can be displayed for each subwatershed
by displaying the theme with a graduated color legend using the
‘Sum_its_po’ column (figure 9).

The example above describes how to use areal interpolation to
distribute a single population characteristic from census block
groups to subwatersheds. To add other census characteristics to the
study add a new field for each attribute of interest and repeat the
process.

Areal interpolation relies on the assumption of evenly distributed
population throughout the blockgroup. Other methods are available
to assign population characteristics to different boundaries, such as
Dasymetric mapping. Dasymetric mapping is a process of display-
ing population distributions within each subwatershed. See Steven
Holloway, James Schumacher, and Roland Redmond's article
People and Place: Dasymetric Mapping Using Arc/Info (1999) for
an example of this mapping technique. Concerns over issues, such
as the effect of the Modifiable Areal Unit Problem (MAUP) and
ecological fallacy, are also important when using census data
across boundaries. Results of the process used here are shown in
the Maps and tables section.

Data issues

Figure 9. Selected subwatershed areas of the Rocky River Watershed, North Carolina.
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Three maps display demographic information for the Rocky River
Watershed, North Carolina (figures 10, 11, and 12). Figure 10 has the
Rocky River Watershed overlaid on the seven counties of the study
area along with the selected subwatersheds. The population densities
for these subwatersheds were calculated using the example methodol-
ogy outlined in this technical note.

Maps and tables

Figure 10 Estimating population attributes by a weighted average technique.
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Figure 11 Rocky River Watershed study area.

Figure 11 provides information on the calculated densities for
County Block Groups of the seven counties. This information was
attained using the 1990 census information as outlined in this meth-
odology.
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The map in figure 12 displays detailed population density informa-
tion for the subwatersheds.

Figure 12 Estimating population attributed by a weighted average technique.

North Carolina

Rocky River Watershed
North Carolina
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Table 1 displays the aforementioned population density for the sub-
watersheds, and it is specifically correlated to figure 12. Table 2 is
selected population attributes for the Rocky River Watershed, such
as gender and race. These attributes were generated by estimating
the block group values within the watershed boundary. They may be
of interest in a watershed study; however, there are some limitations
of these data in the GIS environment.

The STF1A data source for this procedure is limited when estimating
descriptive characteristics, such as median age, median home values
or median family income.

These percentages are used in the weighted average calculations.
The block census data for the target watershed is displayed in table 3
on page 17 and should be referred to during the procedural discus-
sion.

Table 1 Population density for selected subwatersheds of the Rocky River Watersheds, North Carolina

Site Population Square Population Site Population Square Population
identify miles density identify miles density

101 1476 4.0 373.1 131 1473 5.7 257.0
102 1000 5.6 179.2 132 546 5.8 94.5
105 2343 3.4 691.4 133 560 6.0 93.3
106 404 3.6 112.7 136 299 4.4 68.0
107 844 5.6 150.2 138 613 4.6 134.4
109 2147 6.0 357.4 139 342 5.8 58.8
110 3514 5.9 594.7 140 300 3.4 87.8
111 421 4.2 99.2 182 1007 3.7 274.2
112 630 4.5 141.1 183 403 4.0 101.9
113 1519 3.8 398.8 184 181 5.1 35.3
114 273 5.9 46.4 185 296 5.5 54.1
115 165 3.9 41.8 186 1449 5.8 250.6
117 861 5.5 156.4 187 364 4.1 89.2
118 1133 3.7 307.9 188 2470 5.9 420.9
119 1500 4.1 370.1 189 758 4.3 177.8
120 1753 4.9 360.7 190 576 4.0 143.0
121 441 5.8 75.8 191 8782 6.2 1,410.5
123 698 3.4 203.1 192 672 6.2 108.6
126 467 3.4 137.8 196 711 3.2 222.9
128 553 5.7 97.7 199 282 3.7 76.2
130 753 4.4 170.5

Note: Population, square miles, and population density determined by use of GIS .
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Table 2 Selected population data including the Rocky River Watershed,
North Carolina

Population United States North Rocky River,
Carolina Wisconsin

General 248,709,873 6,628,636 426,658
White 199,686,070 5,008,491 349,599
Black 29,986,060 1,456,323 71,316
Other 19,037,743 163,822 994
Hispanic (any race) 22,354,059 76,726 3,234

Gender:
Male 121,239,418 3,214,290 207,690
Female 127,470,455 3,414,347 218,968

Source: U.S. 1990 Census data

A procedure for estimating census block group data using weighted
averages is demonstrated using data from subwatershed 132 of the
Rocky River Watershed. This subwatershed is situated in Stanly
County, in the northeast part of the watershed (figure 13). The calcu-
lations for population estimate for subwatershed 132 were covered
in this technical note for the section on population density. Overlay-
ing the areas of Rocky River subwatersheds and census block groups
determined in GIS provide the percentage of area in each block
group that lies within the watershed boundry.

Census block group and block data are available from the U.S. Bu-
reau of the Census on CD ROM or from the World Wide Web. The
selected population and attributes used in this technical note are
displayed in the bottom portion of table 3. These data include total
population, median age, the number specified owner-occupied house
units, median house values, number of families, and median family
income. The figures in this table are used to estimate the median age,
median house values, and median family income.

Currently, census block data may be obtained by using the following
procedure:

• Go to the U.S. Census homepage at www.census.gov

• Click on the American FactFinder link
• Select the box with Data Sets
• Click on 1990 Summary tape file

• Select 1990 Summary Tape File 1 (STF 1) – 100-Percent data
• Click on List all Tables

• Select DPI – General Population and Housing Characteristics: 1990
• Click on Next (located at the top of the list of table titles)
• For block group data, check box Show All

• Select block group
• Select a State
• Select a county
• Select a census tract
• Select the Block Group(s)
• Click on Add

• Click on Show Table

Estimating population
attributes by a
weighted average
technique
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Figure 13 Overview at watershed an block group

The Census Bureau Statistical Unit provides assistance to users
having difficulty with this process. They can be reached at
(301) 457–2422.

The percent of each block group’s land area was previously calcu-
lated in a GIS as explained and is also presented in table 3. In this
case 20.8 percent of block group 2 of tract 9907 is in the watershed.

The next step is to determine the population for each block group in
the watershed, and to sum them to display the estimated population
for the subwatershed. This is done by multiplying the population of
the block group by the percentage of its area in the watershed. This
approximation assumes that the population is evenly distributed
throughout the block group because census data are not specifically
geospatially referenced. Because block groups tend to be smaller in
area in more densely populated areas, this alleviates the problem
somewhat. Familiarity with the area in question through map study
or on-the-ground experience can help validate these judgments. In
the example the total estimated population of 546 for the target
watershed 132 is displayed in the table. Any further description of
the population, such as gender or race, may be estimated by the
same procedure.

The attribute of median age may also be estimated for subwatershed
132 by a weighted average technique. The median age of each block
group is displayed in the table. The value for 9907 BG-2 is 33.0 years.
The median age for each block group is multiplied by the estimated
population for each corresponding block group. These values are
then summed. The result is 18,667, which is displayed in table 3. The
estimated population of the watershed subsequently divides this
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value. This was shown to be 546 in the preceding step. That division
provides the estimated median age of 34.2 for subwatershed 132.

This process can be followed for estimating watershed values for the
other selected population attributes. The median home values can be
determined for the watershed. The number of units in each portion
of the block groups in the watershed is determined as above. In
block group 9907 BG-2, 20.8 percent of the 221 units is 45.9. The
estimated number of units in the block is multiplied by the median
home value of the block group, which is $58,300, yielding $2,679,934.
The sum of the units from block group areas in the watershed is 91
units. The total of the median home values for the all units is
$5,390,162. A division of these two values shows the estimated
median home value of $58,996 for the target watershed. The median
family income for the watershed was similarly estimated and is
displayed as $31,792 in the table.

9901 9906 9907 9907
BG-6 BG-6 BG-2 BG-3

Total block group population 1,644 1,240 1,509 1,106

Median age 34.9 35.6 33.0 36.3

Specified owner-occupied units 247 239 221 229

Median (dollars) 63,200 56,800 58,300 66,500

Families 486 374 460 349

Median family income (dollars) 26,524 26,397 34,423 32,648

Percent of BG in subwatershed 132 0.04% 13.3% 20.8% 5.9%

9901 9906 9907 9907 Sums for
BG-6 BG-6 BG-2 BG-3 sub w/s 132

Population subwatershed 132 1.0 165 314 66 546

Median age times population 35 5,874 10,362 2,396 18,667

Median age – weighted average 34.2

Owner-occupied units subwatershed 132 0.1 31.787 45.968 13.511 91

Median ($) times units 6,244.16 18,055.02 2,679,934 898,481.5 5,390,162

Median ($) – weighted average 58,996

Families subwatershed 132 0.2 49.742 95.68 20.591 166

Median ($) times families 5,156 1,313,040 3,293,593 672,255 5,284,043

31,792

Table 3 1990 Census Tract Data Stanly County, North Carolina, for calculation of data for subwatershed 132
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The methodology described in this technical note can be applied to
watersheds across the country by collecting the appropriate data.
TIGER/Line 1990 files are accessible via the Internet at the U.S.
Census Bureau’s homepage at

http://www.census.gov/geo/www/cob/index.html

The TIGER/Line files are extracts from the Census TIGER (To-
pologically Integrated Geographic Encoding and Referencing)
database of selected geographic and cartographic information.
They include files for all counties and statistically equivalent
entities in the United States as well as files for Puerto Rico and
Island Territories.

—U.S. Department of Commerce, 1998

TIGER/Line 1998 files can be purchased from the U.S. Census Bu-
reau. For current TIGER/Line pricing, see the U.S. Census Bureau’s
Web page

http://www.census.gov/geo/www/tiger/index.html

Alternate sites for downloading the TIGER/Line files include the
Environmental Systems Research Institute (ESRI) at

 http://www.esri.com/data/online/index/html

The Census Bureau also maintains a list of vendors who can process
TIGER/Line files at

 http://www.census.gov/geo/www/tiger/vendors.html

Recently, the Census Bureau began making available on their Web
site the 1990 TIGER/Line files processed into ESRI Arc/Info Export
files, shapefiles, and Arc/Info ungenerate ASCII files. These files can
be downloaded at

http://www.census.gov/geo/www/cob/index/html

This technical note encourages the use of GIS technology in water-
shed planning. It walks the reader through a process of overlaying
hydrologic unit information that has census information to obtain
watershed demographics that has higher accuracy than that previ-
ously obtained. Limitations found in this process have been dis-
closed.

The authors do not know of a simple software fix for dividing census
information within a block group along a watershed boundary that
cuts through that block group. Census information itself is not
geospatially referenced data. Because of confidentiality reasons, it is
unlikely that it ever will be. This limitation requires judgment in the
proper distribution of data on a spatial basis.

This technical note describes estimating population attributes by a
weighted average technique to demonstrate how to more fully use
this process. As GIS technology gets better and software improves,
the goal of an all-digital watershed planning process will eventually
become a reality. This technical note is but one small step along that
path.

Conclusion

Data sources
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